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1
This chapter provides

m an overview of Cyberdog 1.2

m an overview of this manual

m a summary of requirements for using the software

m instructions on installing and starting the software

m steps to begin using the software

m sources for additional help

Getting Started With Cyberdog 1.2



An overview of Cyberdog 1.2

Cyberdog1.2 is an integrated suite that gives you full access to the
Internet. Cyberdog allows you to:

m browse and search the World Wide Web

m receive, send, sort, and process e-mail

m read, search, and retrieve articles from Usenet newsgroups

m browse AppleTalk zones and servers

m exchange files with file transfer protocol (FTP)

m log in to other computers with Telnet software

m create interactive Internet documents called cyberdocuments

Using this manual

Cyberdog provides you with full access to the World Wide Web, as
detailed in Chapter 2, “Exploring the World Wide Web.” Cyberdog is
also a versatile and powerful tool for electronic mail (e-mail).
Cyberdog e-mail capabilities are covered in Chapter 3, “Sending and
Receiving Mail.” Cyberdog also provides access to other popular and
useful Internet services, including newsgroups, Telnet, and file transfer
protocol (FTP), which are covered in Chapter 4, “Using Other Internet
Services.” A unique Cyberdog feature is the ability to access
AppleShare volumes directly from the browser. This is covered in
Chapter 5, “Accessing AppleTalk Networks.” With Cyberdog, you can
both access information and make information available. You do the
latter by creating cyberdocuments that can be accessed by other
Cyberdog users. For information on building cyberdocuments, see
Chapter 6, “Creating Cyberdocuments.” 

Depending on your interests and experience, you can cover each topic
in order or skip directly to those topics you need to know more about. 
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Using online help

Cyberdog 1.2 includes full online help in the form of Apple Guide. If you
need help or more information on any topic in this manual or on any
problem you encounter while using the software, open the Guide (h)
menu and choose Cyberdog Guide. Then click the topic you need 
help with.

New features of Cyberdog 1.2

Cyberdog 1.2 contains the following new features:

m The Cyberdog 1.2 folder has been reorganized and some items have
been renamed (for instance, Cyberdog Starting Point is now called
Cyberdog Tour). The folder contains a new cyberdocument called
Info & Updates, which provides essential information as well as links
to the Software Updates web page, the Cyberdog Home Page, and
third-party plug-ins.

m The mail system has improved usability; for instance, the New
button in the Mail Trays dialog box has a pop-up menu that allows
you to easily make letterhead selections.

m You can drag any file on your desktop to a Notebook or 
HTML window.

m You can import Claris Emailer addresses into your notebooks.

m Cyberbuttons have been enhanced. You can now create clear buttons
that can be placed over background pictures, have a button display
the icon of the item it points to, and assign a button a text label. You
can also tell a button to open its item in place so that the item
appears within the same document instead of opening a new window.

Using Cyberdog 1.0 or 1.1 documents with Cyberdog 1.2

You can use most Cyberdog 1.0 or 1.1 documents, such as notebooks,
with Cyberdog 1.2. However, if you create a cyberdocument using
Cyberdog 1.2, it will not work with previous versions of the software.

In addition, all mail and news accounts can be transferred seamlessly.
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System requirements

In order to use Cyberdog, you’ll need these items:

m a PowerPC-, 68030-, or 68040-based computer using the Mac OS

m Macintosh system software version 7.5 or later. Version 7.5.3 is
strongly recommended.

If you have an earlier version of the system software, you can obtain
an upgrade from your Apple-authorized reseller. You can also obtain
the software from the Internet at http://support.info.apple.com. 

m OpenDoc version 1.1 or later, which you can download from the
Internet. A pointer to the OpenDoc Web page is included on the
Cyberdog Web page at http://cyberdog.apple.com.

m QuickTime software version 2.1 or later, which may be included with
your system software and can also be downloaded from the Internet
at http://support.info.apple.com

m MacTCP 2.0.4 or later, which is included with the system software, or
Open Transport 1.1 or later, which can be downloaded from the
Internet at http://support.info.apple.com

m MacPPP version 2.5 or later or other SLIP/PPP software for dial-up
connection

m a SMTP/POP3 mail account

m 16 megabytes (MB) of random-access memory (RAM) are
recommended. If virtual memory is turned on, Cyberdog will run
with 8 MB of RAM.

m a Mac OS–compatible modem capable of transmitting data at 14.4
Kbits per second (Kbps) or faster connected to a telephone line, or
direct Internet access through a local area network (LAN)

Also recommended are

m MacPPP or other SLIP/PPP software for dial-up connection from an
AppleTalk network

m Internet Config 1.2 or later for more efficient handling of preferences

m Stuffit Expander for expanding compressed downloaded files
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Before you get started

Before you can use your Cyberdog software, you must possess basic
Macintosh skills, including the ability to

m use icons

m use the mouse and keyboard

m open and close files, windows, and folders

m use dialog boxes

See the instructional materials that came with your computer for
information on these and other important topics.

Installing the software from the Internet

Follow these instructions to install the Cyberdog software from the
Internet:

1 Using your current browser (Cyberdog or another browser), connect to the Cyberdog
Home Page.

The Uniform Reference Locator (URL), or address, of this page is
http://cyberdog.apple.com

2 Locate the section named “Downloading Cyberdog Software.”

3 Follow the instructions on the screen to download Cyberdog 1.2 and Cyberdog Guide.

Be sure to download the PPC version if you have a PowerPC-based
computer, or the 68K version if you have a 68030 or 68040 computer.
The same Guide software works for both versions.

4 Return to the Cyberdog Home Page and click the pointer to the OpenDoc Home Page.

5 Download OpenDoc version 1.1 or later.

6 Install OpenDoc and Cyberdog following the instructions on the screen.

IMPORTANT  You must install the OpenDoc software first.

The Cyberdog installation creates a folder called Cyberdog 1.2.
OpenDoc is installed within the System Folder.

7 Drag the Cyberdog Guide file to the Cyberdog 1.2 folder.
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Starting up

Follow these instructions to start Cyberdog 1.2:

1 Double-click the Cyberdog 1.2 folder to open it.

2 Double-click the Cyberdog Tour icon.

The Cyberdog Tour window appears.

Each of the Cyberdog Tour buttons either allows you to search an
Internet service (such as the World Wide Web, e-mail, or newsgroups)
or connects you to important elements of Cyberdog, such as the
Notebook or the Log.

m Explore connects you to a Cyberdog page on the World Wide Web.

m Mail displays e-mail that you have sent or received.

m Notebook keeps your most frequently used e-mail addresses and
your favorite Internet locations.

m Log records the Internet locations you’ve visited.

m AppleTalk opens a window that allows you to browse and connect to
AppleShare servers (if you are connected to an AppleTalk network).

m News brings up a list of the newsgroups to which you have access.

m Search enables you to scan the Internet using a variety of popular 
search engines.
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Learning to use the software

This manual provides basic information on all the features available
through the Cyberdog Tour window. As noted earlier, detailed online
help is also available. To learn how to use Cyberdog, follow these
instructions:

1 Read the section of this manual that covers the feature you want to use.

2 Click the Cyberdog Tour button that starts that feature.

As an example, choose Mail (for electronic mail) or Explore (to browse
or “surf” the Web).

3 Choose Cyberdog Guide from the Guide (h) menu.

4 Click Topics.

5 In the list that appears, click a topic that deals with the kind of Internet program you’re
using (for example, a mail or news program).

6 Locate the task you want to accomplish and double-click it.

7 Read the information and follow the instructions in the Guide panels.

For more information on using onscreen guides, see the “Learning the
Basics” topic of Macintosh Guide, available in the Guide (h) menu
when the Finder is the active program.

There may also be additional help for specific features. Check the
Guide (h) menu and other menus to see what’s available.

For additional help and troubleshooting information

If you need answers to questions that you can’t obtain from this manual
or Cyberdog Guide, one place to turn is the Cyberdog list of Frequently
Asked Questions (FAQ). Available on the Internet at
http://cyberdog.apple.com/br/techfaq.html, the FAQ is an ongoing
document that is continually updated as new questions come in.

Other Cyberdog documentation is available on the Internet at
http://cyberdog.apple.com/documentation.html.
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Starting up

Follow these instructions to start Cyberdog 1.2:

1 Double-click the Cyberdog 1.2 folder to open it.

2 Double-click the Cyberdog Tour icon.

The Cyberdog Tour window appears.

Each of the Cyberdog Tour buttons either allows you to search an
Internet service (such as the World Wide Web, e-mail

The World Wide Web refers to the portion of the Internet that provides
information according to the Hypertext Transfer Protocol (http), a
standard that enables the exchange of both graphics and text. The Web
is the section of the Internet that has grown most explosively over the
past few years, with companies, organizations, and individuals setting
up Web pages by the thousands. 

This chapter provides information about

m how the Web works

m using Cyberdog 1.2 to browse through information on the Web

m using Cyberdog 1.2 to search for specific information on the Web

m adding Web sites to your notebook

m importing Netscape bookmarks

15
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How the Web operates

The World Wide Web is the Internet’s newest and easiest service for
accessing information. The Web presents information in easy-to-read
screens, or “pages.” On a Web page, you can click a graphic or an
underlined name, fact, or concept that you want to know more about,
and your click takes you to another Web page with the information 
you requested.

You are transported from one page to another by a hypertext link—an
electronic connection to the new information activated by your clicking.
The new information may reside in the same computer or in one on the
other side of the world. Gaining access to distributed information
through hypertext links is at the heart of the World Wide Web.
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Browsing the Web

This section tells you how to use Cyberdog to “surf” (browse) the Web.

1 Open the Cyberdog Tour window.  

Double-click the Cyberdog Tour icon in the Cyberdog 1.2 folder. The
screen shown below appears:

2 Click the Explore button.

A small opening window and a moving dog icon appear, indicating that
your computer is in the process of connecting. The message next to the
icon indicates which phase of the connection is in progress.

To cancel the connection, click the dog icon.
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W hen enough in fo rm a tion has arr ived, the win d ow exp ands to full si z e
and dis plays the Cybe rd og Net St a tion page. F rom the Net St a tion, yo u
can acc ess the entire In t e rnet. 
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Cl ick ing any of the underl ined items takes you to that site or servic e. 
I f, for exa m pl e, you cl ick “Ap ple Computer Home Page,” a page si m i la r
to the fol low ing appe a r s :

D e pe n d ing on how the Web page author desig ned the page, links can
a p pear as butto n s, or they can appear as “hot text,” text that is
u n d e rl ined and in a co n t r as ting color (if your dis play su p p o rts colo r ).
By cl ick ing from one link to the next you can search a series of Web
p ages in pursuit of the in fo rm a tion you're seeking. 
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3 Click an underlined item or a button.

W hen you cl ick, a hy pe rt ext link takes you from one page to an o the r.
For exa m pl e, cl ick ing Van Gogh on a page about artists may lead yo u
to a page about Van Gog h’s homeland, the Nethe rlan d s. That page is
l ikely to in clude links to articl es about win d m i l ls, tul i p s, and rel ig io us
tol e r an c e. Before lo ng, you can be far afi eld from your starting poin t .
( You can see why the software you use to navigate the Web is called a
browser.) There are a variety of me ans to retrace your path or return to
the page where you started. 

4 Return to the previous page by clicking the left-pointing arrow in the upper-right corner
of the page.

Cybe rd og main t a ins a list of all the pages yo u’ve linked to du r ing a
single session, so you can easi ly find your way ba ck to previo us pages.
Ea ch ti me you fol low a link, Cybe rd og notes the Web page you left .
La t e r, you can acc ess that col l e ction of notes and return to any page
be tween your starting point and your current loca tio n. For mo r e
in fo rm a tion, see the “Browsing the Web” to pic area of Cybe rd og Guid e,
ava i la ble in the Guide (h) menu when Cybe rd og is active.

5 Go to a page of your choosing by selecting the text in the Location window at the top of
the screen. Then type the address of the site you want to go to and press Return.  

If you don’t have a publ is hed address readily ava i la ble from a print or
o ther so u r c e, try http://www. cybe rd og. a p pl e. co m.

Note: You don’t have to type in the Web URL p r efix http://. If you don't
s pe cify a URL prefi x, Cybe rd og auto m a tica l ly assu mes you want to
co n ne ct to a Wo rld Wide Web page.
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S e arching for sp e cific information

You can search for spe ci fic in fo rm a tion on the Web by using a search
e ng ine to isolate lists of links that are likely to bring you to the
in fo rm a tion you ne e d .

1 Open the Cyberdog Tour window.

Do u bl e - cl ick the Cybe rd og Tour icon in the Cybe rd og 1.2 folder or, if
Cybe rd og is ru n n ing, choose Open from the File menu and open 
Cybe rd og To u r.
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2 Click the Search button.  

A moving dog icon and a status bar appe a r, in d ica ting that yo u r
computer is in the proc ess of co n ne cting. The message next to the ico n
in d ica t es wh ich phase of the co n ne ction is in prog r ess. To can c el the
co n ne ction, cl ick the dog ico n. When the co n ne ction has been made, a
p age si m i lar to the fol low ing appe a r s :
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3 Enter your query in the text box.

Th is text box allows you to enter a si m ple query. If you want to 
enter a more co m pl ex query, wh ich pe rmits you to foc us your 
s e a r ch more clo s ely, cl ick the Alta Vista link and go dir e ctly to the 
Alta Vista Web page.

4 Click Search.

An alert box appears wa rn ing you that the doc u ment is not secure:
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5 Click OK.

The search beg in s, with results si m i lar to those shown below.

There are nume ro us search eng ines ava i la bl e. Many of these can be
a cc essed from the Cybe rd og Net St a tion, dis c ussed earlier in th is
ch a p t e r. They all work the sa me way. Tr ial and error will show yo u
wh ich eng ines give the best results to your queries.
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Adding Web sites to your notebook

As you find Web si t es you th ink yo u’ll want to revisi t, you can add the m
to a Cybe rd og noteb o o k. That way, you can co n ne ct si m ply by doubl e -
cl ick ing the URL in the noteb o o k, with no need to reme m ber or type the
URL itsel f.

1 With the Web page you want to add open on the screen, open a Cyberdog notebook.

You can open a notebook by cl ick ing the No t ebook button in the
Cybe rd og Tour win d ow, by ch o o sing Open from the File menu an d
s el e cting a notebook to open, or by doubl e - cl ick ing the No t ebook ico n
in your Cybe rd og 1.2 fold e r. After you have been using Cybe rd og for a
wh i l e, you may have several noteb o o ks. If you are new to Cybe rd og,
you have a sa m ple noteb o o k, called Cybe rd og 1.2 No t eb o o k, wh ich
a l r e a dy co n t a ins a sel e ction of Web si t es and e-mail address es.
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2 Click the icon in the top-left corner of the browser, next to the title of the page you’re
using, and drag the icon to the appropriate section of the notebook.

Since th is is a Web page, the appro p r iate section is Cybe rd og In t e rne t
Reso u r c es. An abbrevia tion of the URL is added to the list. The next
ti me you want to acc ess th is page, si m ply doubl e - cl ick the 
n o t ebook entry. 

For additional in fo rm a tion, see the “Saving and Organ i z ing Ad d r ess es”
to pic area of Cybe rd og Guid e, ava i la ble in the Guide (h) menu whe n
Cybe rd og is active.
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Importing Netsc ape bookmarks

If you have been using Netsca pe and have created bookmarks to acc ess
Web pages, you can import those bookmarks in to Cybe rd og.

1 Open the notebook you want to store the bookmarks in.

2 Choose Import Items from the Notebook menu.

3 Choose Netscape Notebooks from the Import Items submenu.

A dia log box appears with Bo o k m a r ks. h tml already sel e ct e d .
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4 Click Open.

As shown in the fol low ing screen, a new ca t ego r y, Bo o k m a r ks. h tm l, is
added to your noteb o o k. If you cl ick the triangle next to the ca t ego r y
he a d ing, all the bookmarks appe a r. Do u bl e - cl ick ing any one of the m
t a kes you dir e ctly to that Web page.

Note: You can also import Eudora and Cla r is Emailer address es; thes e
o p tions are ava i la ble in the Im p o rt Items su b me n u.

A note about performanc e

So me ti mes co n ne cting to a Web site may take lo nger th an you expe ct .
Several fa ctors can affe ct co n ne ction ti me, in cl u d ing your mo d e m’s
s peed and the dis t ance to the si t e. 

O ne of the most import ant fa cto r s, howeve r, is the server that yo u’r e
co n t a cting. So me ext r e mely popular servers may be proc essing many
r e q u ests for use at the sa me ti me, and so me servers are just slower th an
o the r s. After a wh i l e, yo u’ll learn wh ich servers provide you with the
best pe r fo rm an c e.
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When enough information has arrived, the window expands to full size
and displays the Cyberdog Net Station page. From the Net Station, you
can access the entire Internet. 

You use electronic mail (e-mail) to exchange messages much as you use
paper mail or a fax machine. 

This chapter describes how to

m determine if e-mail is set up

m set up Cyberdog for e-mail

m use the Cyberdog e-mail features

m address and send e-mail

m attach a file to your e-mail message

m create an address book

m import Eudora addresses

m use Cyberdog letterheads and create signature files

29
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Checking whether e-mail is set up

Follow these steps to check whether you have e-mail already set up:

1 Open the Cyberdog Tour window.  

Double-click the Cyberdog Tour document in the Cyberdog 1.2 folder,
or, if Cyberdog is already running, choose Open from the File menu
and open the Cyberdog Tour window.

2 Click the Mail button.

If you have been using a mail application with mail preferences already
set up in Internet Config, such as Eudora, Cyberdog opens the Mail
Trays window and displays an In Tray corresponding to that Internet
mail account, indicating that your Cyberdog mail account is set up and
functioning.

If the In Tray shows that mail has been received, continue to the next
section for information on receiving and replying to mail messages.

If Cyberdog prompts you to use Mail and News Setup from the
Mail/News menu, or if you want to change your mail settings, you need
to set up mail. Follow the directions in this section. For additional
information, see the topic area “Getting Started” in Cyberdog Guide,
available in the Guide (h) menu.



Setting up Cyberdog for e-mail

The following section provides a basic setup scheme. For detailed
information, see Cyberdog Guide as you perform these steps.

IMPORTANT  In order to use Cyberdog mail, you first need an Internet
mail account that uses the POP protocol to receive mail and the SMTP
protocol to send mail. Your Internet service provider can give you the
information you need to set this up.

1 Choose Mail and News Setup from the Mail/News menu.

The dialog box shown below appears.

2 Enter a default mail address.

This is your standard e-mail address, such as Lsmith@bigcom.com. It
appears in the From field on your messages and is the address people
use to send you mail.

3 Enter the name of your SMTP host.

Your network administrator can tell you what name to enter.
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4 Choose the mail notification features you want: a dialog box, a flashing icon, a sound, or
all three. 

If you don’t check any notification type, you won’t be notified, but you
can still check mail at any time.

5 Click the Mail Trays icon.

6 Click Add under mail accounts. 

The dialog box shown below appears. You use this dialog box to set up
your POP account to download mail from the Internet mail server. 

7 Enter your account name.

This is your user name, not your e-mail address; for example, if your
e-mail address was bonzini@internet.com, you would enter bonzini).

8 Enter the host.

This is the mail server, such as mail.bigcom.com, as supplied by your
Internet service provider.

9 Enter your password.

Your network administrator will usually provide you with the password
to use. 

10 If you want to save your password, click Save Password.

If you click Save Password, you won’t have to enter your password each
time you download mail.

11 Choose the settings you want for checking mail.

If you leave all of these blank, you can still check mail manually.
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12 If you want to leave copies of mail on the server, click the “Leave a copy” checkbox.

You probably only want to leave copies of the mail on the server if you
are reading your mail from several different computers rather than one
computer.

13 Click the Messages icon.

The Messages screen appears.

14 Enter the name you want to appear on your messages.

15 Enter the settings you want for displaying and closing messages.

16 Enter the settings you want for aging messages.

Opening and replying to a message

Once you find mail in your In Tray, follow these steps to open
messages, send replies to the messages you receive, and file received
messages:

1 Open the Cyberdog Tour window.

2 Click the Mail button.

3 Double-click the In Tray icon.  

A list of the messages that you’ve received appears. Checkmarks appear
beside messages that you've already read. 

Note: You can remove the checkmark by clicking on it if you want to
mark the message as unread.

4 Double-click the message you want to read.

A message window appears. 

5 Use the onscreen buttons to forward, reply to, file, or delete the message.

Composing and sending a message

This section takes you through the steps of composing and sending an
e-mail message with Cyberdog. 

1 Open the Cyberdog Tour window.  

2 Click the Mail button.
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3 From the Mail/News menu, choose New Message.

A message window appears, and the Letterhead dialog box opens.

4 Choose the letterhead you want to use and click OK.

For more information on using letterheads, see Cyberdog Guide.

5 Address the message.

If this is a new address, type it in the To box. Otherwise you can enter it
by dragging the icon from the Notebook, or by clicking the Addresses
button in the message window. See Cyberdog Guide for more
information.

E-mail addresses usually take this form:

recipientName@recipientMailServer

where recipientName is the name that the recipient goes by when he or
she connects to that mail server and recipientMailServer is the
recipient’s mail server name.

You can also address an e-mail message by double-clicking an e-mail
address icon or clicking an e-mail link on a Web page. Doing so opens
a new e-mail message form with the e-mail address already in place.

You can send the same electronic message to multiple recipients by
adding additional addresses.

About suffixes:  An e-mail address usually ends in a two- or three-letter
code. This code identifies the country in which the server is located
(two letters) or the kind of organization with which the mail server is
associated (three letters). Some common national codes are “us”
(United States), “jp” (Japan), “uk” (United Kingdom), and “fr”
(France). Common organizational codes include “com” (commercial),
“edu” (educational), and “gov” (government).

Some recipient names consist of numbers instead of letters. The
CompuServe online service, for example, formerly required that you
use the recipient’s member number, with the comma replaced by a
period (for example, 12345.678@compuserve.com). CompuServe now
allows members to use names, but many members still use the old 
address form.
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Here is a list showing how to address mail to members of other popular 
online services:

Service Addressing method

America Online recipientName@aol.com

Prodigy recipientName@prodigy.com

MCI Mail recipientName@mcimail.com

Because e-mail addressing specifics can vary, and because there is as
yet no reliable or even remotely complete address database, the only
way to know what e-mail address to use is to get it directly from a
recipient, a recipient’s correspondence or newsgroup posting, or a
recipient’s associate.

Copies and blind copies:  Just as you can send copies (cc) of paper
mail, you can send copies of e-mail. People receiving copies of your
message also receive copies of any attached files (described later in 
this chapter).

Recipients who receive “blind copies” (bcc) also receive copies of
everything sent to the main recipient. None of the recipients, however,
knows who the bcc recipients are, because names and addresses of
blind recipients are removed from the message when it’s sent.

6 Enter the subject.

Type the subject of the message. 

IMPORTANT  You must include a subject or the message cannot be sent.

Many people who receive a lot of electronic mail determine whether
they’ll read a message based on this field. This is especially true if they
don’t know the sender. As you receive more e-mail you may need to
screen it by subject or sender.  
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7 Type your message.

If you know how to use any plain text editor or word processor, you can
compose an electronic message in Cyberdog. You type your electronic
message using all of the standard Macintosh editing features, just as
you would type a fax or a letter to be printed and mailed. You can use
any available font, size, style, and color, but keep in mind that the
recipient’s mail application might affect the look of your message. If the
e-mail recipient’s system can’t take advantage of the styled text and
graphics, it is probably best to stick to plain text. To specify a plain text
message, choose Plain Text from the pop-up menu at the bottom right
of the message header. 

8 Add any graphics that you want to include in the body of your message. 

9 Add any files that you want to include with your message. 

To add a file, drag it to the text area of the message, or click the Enclose
button in the message window.

You can attach files in any format you want. Some cautions are in order
here, however. The recipient’s computer must be able to understand the
attachment’s format. For example, if your recipient’s computer is an
IBM mainframe, it won’t be able to read a HyperCard stack. 

Additionally, not all mail server systems are set up to receive
attachments. An attachment sent to such a system can get removed in
transit, show up as garbled mail, or cause the whole e-mail message to
be rejected. 

To make sure that a mail server can receive and understand an
attachment, contact your intended recipient and ask. If your recipient
doesn’t know, try sending a test attachment first.

10 If you want to include links to AppleShare servers or Internet locations, drag those items
from the Notebook to the message window.

11 Send your message by clicking the Send button if you are connected to the Internet or
the Send Later button if you are not currently connected.

If you click the Send Later button you need to choose Send Now from
the Message menu once you connect to the Internet to send the message.
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Adding, deleting, and renaming addresses

A Cyberdog notebook can hold e-mail addresses as well as URLs. 

Follow these steps to add an address to a notebook:

1 Open the notebook you want to use.

Click the Notebook button in the Cyberdog Tour window or open a
notebook from the File menu.

2 Drag an address from an open e-mail message to the E-Mail Addresses category of 
the notebook.

Alternatively, you can choose Add E-mail Address from the Mail/News
menu, then type the address.

You can use any of these methods to delete an e-mail address or other
entry from the notebook:

m Drag the notebook item to the Trash.  

m Select a notebook item and press the Delete key.  

m Select a notebook item and choose Delete <Item> from the Edit menu.

To rename an e-mail address or other notebook item:

1 Select the name of the item you want to rename.

2 Choose Rename <Item> from the Edit menu.

You cannot rename a notebook item by selecting it and typing over it. 

3 Type the item’s new name.
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Importing Eudora addresses

If you are currently using the Eudora mail system, you can import your
Eudora addresses directly into Cyberdog.

1 Open a Cyberdog notebook.

2 Choose Import Items from the Notebook menu.

3 Choose “Eudora nicknames” from the Import Items submenu.

4 Select “Eudora nicknames” from the dialog box that appears and then click Open.

The addresses are automatically added to the E-Mail Addresses section
of the notebook.

Using letterhead and signatures

You can use e-mail letterhead to include graphics, text, or both in all
your messages automatically. Like paper letterhead, e-mail letterhead
usually includes a company name, traditional mailing address, voice
and fax telephone numbers, and the like. For details, see the topic area
“Sending Mail” in Cyberdog Guide, available in the Guide (h) menu
when Cyberdog is active.
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In addition to the Web and e-mail, Cyberdog offers access to these 
Internet services:

m Usenet, the Internet's open discussion forum, which offers a
collection of publicly accessible newsgroups for debate and
information exchange 

m FTP (File Transfer Protocol), which enables you to exchange files
with computers on the Internet and sometimes to retrieve programs
that more general Internet software cannot 

m Gopher, which allows you to find and access files anywhere on 
the Internet

4 Using Other Internet Services



Subscribing to Usenet newsgroups

Usenet is an open discussion forum that covers a vast array of subjects.
To use Usenet newsgroups, you must first establish a connection to
your Internet access provider’s news server. For detailed information,
see the topic area “Getting Started” in Cyberdog Guide, available in the
Guide (h) menu when Cyberdog is active.

IMPORTANT  Some newsgroups may include articles with software you
can retrieve from the Internet and use. Although Apple Computer, Inc.,
does not provide technical assistance for the software you download
from the Internet, the software’s creators may provide technical support.
Check the documentation files that you retrieve with the software to 
be sure.

Usenet basics

Usenet is made up of thousands of electronic discussion forums called
newsgroups. Each newsgroup is composed of a series of electronic
messages (called articles) on a given topic. The article themes (which
Cyberdog and many other news readers call threads) can be anything
related to those topics.

The following illustration shows a list of typical articles and threads
from the newsgroup called rec.arts.books. (For a description of
newsgroup names, see “Understanding Newsgroup Names,” later in 
this chapter.)
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With Cyberdog, you can read the articles in any newsgroup and
respond to them by sending e-mail to the entire newsgroup or to the
article’s author (known as the poster). In most newsgroups, you can also
respond by “posting a follow-up”—that is, publishing your own article.
Additionally, you can start your own discussion, or “initiate a thread.”
And you can even propose a topic for an entirely new newsgroup. 

IMPORTANT  The group news.announce.newusers is the first newsgroup to
which you should subscribe. Read the articles in this newsgroup before
you post an article of any type, or even respond to an article by e-mail.
These articles are written and updated by extremely experienced
newsgroup users and present excellent suggestions for making your
time on Usenet productive and enjoyable. Articles in this newsgroup are
updated and reappear often, most on a monthly basis. They are
important reading for every new Usenet user.

Most Internet access providers don’t carry all the newsgroups available
because there are so many of them. Currently there are well over
10,000 newsgroups worldwide (not counting newsgroups restricted to
smaller communities, colleges and universities, and corporations), and
newsgroups are constantly being created and abandoned. A new one is
created when enough people feel the need for it; an old one goes out of
existence when people stop posting articles to it.

Understanding newsgroup names

You can tell what a newsgroup is about by examining its name. When a
name has more than one part to it, the parts are separated by periods,
and go from most general to most specific, left to right. For example,
the newsgroup soc.culture.ecuador covers social topics (“soc”) having to
do with the customs, habits, arts, and day-to-day life (“culture”) of the
people of Ecuador.

The first word in a newsgroup’s name is considered the top-level
hierarchy name, which indicates the newsgroup’s main subject matter.
Cyberdog displays this hierarchy analogously to the way files are
displayed in the Mac OS file system. Each category has a triangle next
to its name, as does a Mac OS folder. Clicking that triangle shows its
contents. Clicking the triangle again closes the category.
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Following is a list of some of the most widely read or important
hierarchies. Some of these newsgroups may not be available to you.

Hierarchy Subject matter

alt Unrestricted, often controversial subjects such as sexuality, drugs, and politics 
(not all groups carried by all sites)

biz Business topics, product reviews, demonstration software

comp Topics in the world of computers

hiv Information about HIV and AIDS 

k12 Kindergarten through grade 12 educational curriculum, classroom projects,
language exchanges with native speakers, general “kid-to-kid” chatting

misc Themes not easily categorized under other hierarchies

news Groups concerned with newsgroups and Usenet itself

rec Recreational pursuits, arts, and hobbies

sci Research findings in, discussions about, and applications of recent discoveries 
in the established sciences

soc Social issues and socializing (not all groups carried by all sites)

talk General discussions of a freewheeling nature on every topic (not all groups 
carried by all sites)

Private newsgroup servers: Some newsgroups are not publicly available
and appear only on a single server. For example, a company might set
up newsgroups accessible only to employees or only to members of a
particular work group. The Cyberdog newsgroups listed in your First
Notebook are available only from the news server at cyberdog.apple.com.

To see all the newsgroups your ISP provides, select Show News Groups
from the Mail/News menu. For more information on newsgroup names,
see the article “Guidelines on Usenet Newsgroup Names” in the
newsgroup news.announce.newusers.
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Subscribing to a newsgroup

Once you locate a newsgroup that you’re interested in, you subscribe 
to it—that is, you drag its icon to a notebook. Whenever you want to
read articles in that group, you double-click its icon and the 
newsgroup opens.

Cyberdog keeps track of the articles you’ve already read so that you
don’t have to sift through them again each time you open a newsgroup.

Newsgroups for Macintosh users

Many newsgroups are of interest to Macintosh users.

The following list, while not exhaustive, presents a sampling of what’s
available for users at all levels of expertise.

alt.sys.mac.newuser-help

New users ask questions here, and experts (and sometimes other new
users) answer them.

aus.computers.mac

Australians swap all manner of Macintosh information here. While
some topics apply only to local people (“Is there a decent software store
in Sydney?”), most are more general.

biz.marketplace.computers.mac

One of Usenet’s groups set aside for buying and selling, this newsgroup
contains listings of new and used hardware and software for sale or
trade. Be sure to read the FAQs before you post an article or purchase
an item.
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comp.binaries.mac

This group contains software that you can download and use. You may
be expected to send a small payment to the author after you’ve used the
software for a while and decided to keep it. 

comp.sys.mac.*
The comp.sys.mac.* newsgroups concern themselves with all manner of
things Macintosh, and are all highly recommended. (The asterisk [*] is
a “wild card” character and stands for any word that specifies a
particular group.) There are currently about 30 such newsgroups.
Names include comp.sys.mac.games, comp.sys.mac.hypercard,
comp.sys.mac.portable, and comp.sys.mac.printing. The newsgroup
comp.sys.mac.comm is likely to have discussions about Cyberdog.

cyberdog.*
The cyberdog.* newsgroups provide discussion space for Cyberdog
issues. Newsgroups include cyberdog.announce (information about new
Cyberdog releases, documentation upgrades, and the like),
cyberdog.general (general discussion of Cyberdog issues), cyberdog.hi-
features (human interface issues and suggestions), and
cyberdog.programming. 

Note:  Cyberdog newsgroups are not available through your Internet
access provider. They are available only through the
cyberdog.apple.com news server. Access to this server is already set up
for you in the News Groups window.

WARNING  Some software in the comp.binaries.mac newsgroup is in
a developmental rather than finished stage. Software that is in a
developmental stage may “freeze” your computer system. In such
a case you’ll have to restart your computer, and any unsaved
changes to open files will be lost. Apple Computer, Inc., does not
guarantee or provide technical support for any of the software in
this or any other newsgroup.
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fj.binaries.mac

This group is like comp.binaries.mac, except in Japanese. In most
cases, you need to have a set of Japanese-language fonts installed on
your computer to read these articles.

fr.comp.sys.mac

This group contains articles about all manner of Macintosh issues 
in French.

misc.forsale.computers.mac-specific.*
Like biz.marketplace.computers.mac, this series of groups contains
listings of new and used hardware and software for sale. There are
separate groups for video cards, portable computer systems, software,
and more.

tamu.micro.mac

This group has Macintosh-related information of interest to students at
Texas A&M University. Usenet has many such hierarchies of special
interest to the students and faculty of individual universities (such as
“ucb” for the University of California at Berkeley and “osu” for Ohio
State University) and geographic areas (such as “ba” for the San
Francisco Bay Area and “nyc” for New York City).
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Transferring files with FTP

You use FTP (File Transfer Protocol) to exchange files with computers
on the Internet. 

Anonymous FTP archives

Anonymous FTP archives are collections of files to which you can gain 
access without an assigned password. Such files include application
software, graphics, collections of sounds, and databases. These archives
are often maintained by universities, government agencies, and large
computer companies. 

Many computer sites allow access to their files only if you have a user
ID (also called a login name) and a password assigned by the site
administrator. Anonymous FTP archive sites, however, accept the word
“anonymous” as the user ID and your e-mail address as the password.

Technical support may be available:  Although Apple Computer, Inc.,
does not provide technical support for any software you may retrieve,
the software’s creators sometimes provide technical support. See the
documentation that comes with the software.
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Why do they do it?  Site administrators often find it more convenient
and practical to maintain anonymous FTP archives than to set up
password accounts for everyone who might have a legitimate need to
access certain files. Computer companies, for example, might want to
allow customers free access to system software updates and bug fixes,
while universities might want students to get online catalogs and class
schedules easily. (The Cyberdog software you downloaded from
cyberdog.apple.com was actually at an FTP site.)

Restrictions

The administrators of anonymous FTP sites (the computers where the
archives are stored) often place restrictions on using their archives. You
have access to the files only in certain folders (called directories on
most Internet systems), and there may be limits on the number of files
you can retrieve (download) or the amount of time you can spend
connected to a site. To see what restrictions apply, open the FTP menu
and choose Show Server Messages. You’ll see a window like the one in
the following illustration.

Many sites do not allow you to transfer any files from your computer to
the archive (upload). Still, because all the files that you download are
either free or extremely inexpensive, anonymous FTP is the best deal
on the Internet.
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Finding FTP sites

You can use the Cyberdog Internet Search page to locate FTP sites.
Follow these instructions:

1 Open the Cyberdog Tour window and click Search.

When the Search page opens, you might want to drag the Internet
Search icon at the top-left corner of the window to your notebook.
Most people find that they use Search quite often.

2 Type Mac “anonymous FTP” in the Search field and press Return.

Remember to type the quotation marks around the phrase 
“anonymous FTP.”

3 Click a site name.

You may have to investigate a number of sites before you find one that 
you like.

You can be specific in your searching: You can also use a search engine
to find a specific file or file type. Instead of searching for anonymous
FTP, search for Compression Software and see what happens.

You’ll find a list of useful FTP sites on Cyberdog’s World Wide Web
home page. You can reach that page by clicking the Explore button in
the Cyberdog Tour window, or by connecting directly to the Internet
address http://cyberdog.apple.com.

Finding files in an archive

Many FTP sites have files with titles such as Read Me and Directory
Listings that provide hints about searching the archives. (You can’t use
application software from your computer’s hard disk to locate files at
the anonymous FTP site.) Additionally, many sites have Welcome
messages that appear when you first connect, giving additional hints
about where to look.

In the worst case, you’ll have to browse through directories until you
find what you want, using the directory names themselves as hints.
Start with the directories named “mac” or “pub” (short for “public”).
Browsing directories is simple; you double-click a folder to open it, just
as you do in the Finder. Files and subfolders are always listed
alphabetically, as if “by Name” were chosen in the Finder’s View menu.
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To download a file, just drag its icon to your desktop or hard disk. The
file is copied to your computer.

Using Gopher

You use Gopher to find interesting files no matter where they are on
the Internet. Gopher is like FTP in that you can use it to retrieve files;
but while FTP can only show lists of files that are on the host computer
to which you’re connected, Gopher can show lists of files that are on
many computers. 

Typical Gopher lists are arranged in hierarchies with each folder named
for its content. Using Cyberdog, you browse through folders until you
find the file that interests you. Then you double-click its name to read
it or drag it to the desktop to download it.
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Retrieving and using files

With Cyberdog, you retrieve a file once you’ve located it by dragging 
its icon to the desktop. The file is automatically downloaded to 
your computer.

About file suffixes

You may need to decompress downloaded files before you use them.
Files stored in archives are often compressed in order to save space.
Such files end in a one-, two-, or three-letter suffix preceded by a
period (for example, “pictures.sit” or “files.hqx”).

Many compressed files are automatically expanded by your software.
You may need to expand others yourself with special software. Luckily,
software for expanding compressed files is often available at the same
site that holds the compressed files you were originally looking for.
(See “Finding FTP Sites,” earlier in this chapter.)

About shareware

Shareware is software that you use on approval. Unlike demoware,
shareware is a complete software package. You get all the features, not
just a sample. After you use the software for a while, the author expects
you to send payment or to throw the software away. Shareware is usually
quite inexpensive. 
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Cybe rd og’s Ap pl e Ta lk browser allows you to acc ess Ap pl e Share an d
o ther AFP (Ap pl e Ta lk Fi l ing Pro tocol) serve r s. Ap pl e Share URLs can
be used to open doc u me n t s, la u n ch appl ica tio n s, and open fold e r
w in d ows on remote vol u mes. These URLs can also be added to
Cybe rd og noteb o o ks or embedded in Cybe rd og cus tom doc u ments fo r
later us e.
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Browsing Apple Talk Net works

The Ap pl e Ta lk browser gives you acc ess to zones and servers on yo u r
local area or wide area Ap pl e Ta lk ne two r k. In Cybe rd og, Ap pl e Ta lk
z o nes and Ap pl e Share file servers have their own URLs. Just like
s t an d a rd In t e rnet URLs, these URLs can be added to Cybe rd og
n o t eb o o ks, HT ML Web pages, and Cybe rd og cus tom doc u me n t s.

Ac c e s sing Apple Talk zones and Apple Share file servers

IMPORTANT  To see any th ing in the browser win d ow, your computer mus t
be co n ne cted to an Ap pl e Ta lk ne twork and Ap pl e Ta lk must be active.  

1 Open the AppleTalk browser.

Cl ick the Ap pl e Ta lk button in the Cybe rd og Tour win d ow, doubl e - cl ick
the Ap pl e Ta lk Network lis ting in the noteb o o k, or type in the URL 

at:  

A win d ow si m i lar to the one shown below appe a r s, wh ich is a list of
z o nes for the Ap pl e Ta lk ne twork to wh ich you are co n ne cted. (Th is is
the list you get when you open the Chooser and sel e ct the Ap pl e Sh a r e
ico n.)
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2 To see the AppleShare file servers in a zone, click the triangle next to the zone.

The win d ow below shows the Ap pl e Share file servers in the 
Ma r ke ting zone.

3 To connect to a file server, click the triangle next to the server.

Cl ick ing on the triangle next to a server brings up the authe n tica tion 
d ia log box.

4 Log onto the file server.

Once you ga in acc ess to the serve r, you see a list of ava i la ble vol u mes.
Do u bl e - cl ick ing co n ne cts you to the vol u me and opens its win d ow in 
the Fin d e r.  
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Using Apple Talk and Apple Share URLs  

Ap pl e Ta lk and Ap pl e Share URLs can be used just like stan d a rd
In t e rnet URLs. For exa m pl e, you can put links to Ap pl e Share fi l e
s e rvers on the sa me HT ML Web page as links to In t e rnet reso u r c es.
H oweve r, only pe o ple who browse the Web using Cybe rd og 1.2 will be
a ble to co n ne ct to servers with Ap pl e Ta lk and Ap pl e Share URL links.
For more in fo rm a tion on using Ap pl e Ta lk and Ap pl e Share URLs in
HT ML Web pages go to http://cybe rd og. a p pl e. com and cl ick the
Ap pl e Ta lk Browser link.  

You can enter URLs to acc ess your Ap pl e Ta lk ne twork at any level
f rom zone to fi l e. The fol low ing list shows wh ich URLs match 
wh ich levels :

m AppleTalk network URL  at: (the letters “a t” fol lowed by a colo n )

m AppleTalk zone URL  a t : / / Z o ne Na me

m AppleTalk local zone URL  a t : / / *

m AppleShare file server URL  af p : / a t / Se rver Na me : Z o ne Na me

m AppleShare volume URL  af p : / a t / Se rver Na me : Z o ne Na me / Vol u me Na me

m folder URL  af p : / a t / Se rver Na me : Z o ne Na me / Vol u me Na me : Folder Na me

m file URL  af p : / a t / Se rver Na me : Z o ne Na me / Vol u me Na me : File Na me

You can enter authe n tica tion in fo rm a tion in any Ap pl e Share URL. Fo r
exa m pl e, you can allow gu est acc ess to an Ap pl e Share file server URL 
as fol lows :

m af p : / a t / gu es t @ Se rver Na me : Z o ne Na me

You can add a user name and passwo rd to a file server URL as fol lows :

m af p : / a t / user name : p asswo rd @ Se rver Na me : Z o ne Na me

You can add Ap pl e Ta lk URLs to a notebook exa ctly as you add Web 
p age URLs.

1 Open a notebook.

2 Choose New Item from the Notebook menu.

3 Type the URL and click OK.
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Adding Apple Talk and Apple Share URLs to cyb erdocum ents 

You can use the Ap pl e Ta lk browser and AFP URLs to create uniq u e
ways to acc ess your Ap pl e Ta lk ne two r k’s reso u r c es. Cybe rd oc u me n t s
and web pages can embed Ap pl e Ta lk browser and URL links to yo u r
local Ap pl e Ta lk ne two r k, provid ing acc ess to zones, serve r s, vol u mes,
and fi l es. See Chapter 6 of th is man ua l, “Cr e a ting Cybe rd oc u me n t s,”
for more in fo rm a tio n.
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With DocBuilder, you can quickly and easily create customized access
to Internet or Intranet resources. DocBuilder is an application provided
with Cyberdog that you can use to create cyberdocuments, an entirely
new kind of multimedia document based on Apple’s new LiveObjects
(OpenDoc) technology. Cyberdocuments can include text, graphics,
and Internet information. You can include Internet information through
Cyberdog parts—a notebook, a button that links to information, or a
browser window displaying real-time Internet information. Links can
be to Internet resources, intranet resources, or files on your local hard
disk or network. 

DocBuilder is similar to a drawing application. If you’ve used a drawing
application before, you’ll recognize the tools. If not, you’ll find them
easy to learn. 

This chapter takes you through the building of a sample
cyberdocument, giving a glimpse of all the features available.

6 Creating Cyberdocuments



Unique cyberdocument features

Cyberdocuments can serve many of the same purposes as a Web page,
but they are not the same:

m Cyberdocuments are Macintosh files on your desktop, not on a
remote Web server, as are HTML Web pages.

m You can embed information from multiple Internet sources,
including newsgroups, mail, and AppleShare servers, with 
single-click access to all sources.

m You can add URLs, text, and graphics to cyberdocuments.

m You can provide live views that show the actual content of 
Internet sites.

m Cyberdocuments can be accessed only by Cyberdog users, and each
user must have a copy on his or her computer to access the page.

Using DocBuilder

This section introduces you to the basic DocBuilder controls. You’ll
save time and trouble if you familiarize yourself with the following
information before building your first cyberdocument.

Selecting and editing 

There are two types of selection. When you click a part such as a
button, a dotted frame appears, indicating that the part is “active,”
meaning that you can edit the content of that part. Any DocBuilder
Tools palettes that are open disappear when the part is active, as do the
Layout and Page menus. At the same time, the part’s unique menu
becomes available, indicating that control has passed from DocBuilder
to the part itself (for instance, when you click a button, the
CyberButton menu appears).
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When you click outside an active button or other part, dark squares, or
handles, appear on the corners of the button, indicating that the part 
is selected.

While the part is selected, you can resize the part by dragging one of
the handles. You can also select multiple parts by Shift-clicking and
then align, move, or do other operations with the parts as a group. If
you have trouble selecting a part, try clicking and dragging around it to
select it.

Deleting 

You can delete objects by selecting them and pressing the Delete key.
You can also use Cut or Clear in the Edit menu.

Making documents editable or uneditable

You use layout mode to create your DocBuilder document. When the
document is set to layout, you can add parts, edit text, resize and move
parts, link buttons, and drag in Internet address icons to create new
viewers (in layout mode, a grid of dots appears within the document).

Run mode is somewhat analogous to read-only. In run mode, you 
can only select and change those objects that were set Editable in 
Run Mode.

To make a part within a document unchangeable by the user, select the 
object (so the dark square handles show) and choose Editable in Run
Mode from the Layout menu. The checkmark by the menu item
disappears, indicating that the selected DocBuilder part is no longer
editable in run mode. You can select multiple objects (by Shift-clicking
or by dragging a selection box) and change all of them at once. When a
part is not editable in run mode, the user can't edit the item in any way,
so if you want users to have the option of changing a button, notebook,
or other part within the document, be sure to leave it set to Editable in
Run Mode. Generally, you should set decorative items, such as text
labels, pictures, and other graphics, to be not editable in run mode.
Graphic objects created with the DocBuilder Tools palette are never
editable in run mode.
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Saving a document as run-only

When you save a document you’ve set to run mode, anyone who opens
it can use the Tools palette or Edit menu to change it back to layout
mode. The Save as Run Only option in the File menu “locks” the
document, so that it can’t be changed back to layout. Before saving a
document as run-only, you should also save an editable version. If you
save a document as run-only and later need to edit it, you can open a
new DocBuilder document and drag the run-only document icon into
the new document.

Options for linking a button

You can create a link to a button by dragging the address icon onto the
button from your Log, a notebook, or the desktop. You can also create a
link by using Link To in the CyberButton menu. This method lets you
link to your Log, your default notebook, and any URL.

Adding text to a button

To put text on a button, first create the text using a drawing or painting
program. The text is now the same as a picture. It can be worked with
inside cyberdocuments or added to cyberbuttons exactly as any 
other picture. You can also also type a label on the button using the
Label option in the CyberButton menu.

Using the Scrapbook as a source for graphics and text

You can often drag graphics or text directly from another open
application into DocBuilder. Normally, when you drag something in
from the Scrapbook, you’ll see a light blue border around the
DocBuilder document, indicating that it’s accepting the object. If
DocBuilder doesn’t accept the dragged item, the item zooms back to its
original place. If the item is rejected, either drag or copy and paste the
item into the Scrapbook before dragging it into DocBuilder, and check
that the document is set to Layout (in layout mode, a grid of dots
appears within the document).
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Creating a scrolling text box

You can create scrolling text boxes in DocBuilder. If you create such a
box, be sure to leave that part editable; otherwise the user won't be able
to scroll the box. If you include a large amount of text in a box and
don’t want the user to be able to change the text, you need to use small
enough fonts and create a text field large enough for the user to view
the entire passage without scrolling.

Including existing text

If you have previously written text you want to include in a DocBuilder
document, one option is to copy the text from its original document
and paste it into the document. Another option is to drag a file that's
been saved as text-only from your desktop into the document.
DocBuilder creates a text viewer and displays the text.

Both methods of including text cause most of the formatting to be lost;
only default tabs, spaces, and styling are saved. Once the text is in
DocBuilder, you can edit it, format it, and add additional styling.

Note: Cyberdog cannot show transparent text. You can achieve this
effect by putting the text inside a white fill rectangle, or by using a
draw or paint program to create the background you need.

Controlling navigation in embedded browsers

If you embed a browser window “as is,” it will contain its full header
with a variety of navigation options. Some of these options may not be
appropriate for your purposes. You can use the Navigate menu to
determine what header information appears. The settings you make
with the Navigate menu apply only to the selected browser.



Cre ating a cyb erdocum ent

Th is section takes you step by step th ro ugh the proc ess of using
Doc Bui lder to create a cus tom cybe rd oc u ment that in cl u d es a butto n
l inked to a Web site and an embedded Web brows e r. 

1 Open the Samples and Tools folder.

2 Double-click the Cyberdog DocBuilder icon.

The Doc Bui lder layout win d ow ope n s. The grid of dots, wh ich serves
as a reference grid for alig n ing items, in d ica t es that th is is a layo u t
d oc u ment (as opposed to a ru n - o n ly doc u me n t, wh ich is “locke d” to
p r event it from being edited). A ru n - o n ly doc u ment win d ow has no
g r id of dots. To make the doc u ment ru n - o n ly, cl ick the ru n n ing dog on
the To ols palette. Cl ick ing the ly ing - d own dog ch anges the doc u me n t
ba ck to layo u t, making it editabl e. You can also ch ange be tween Layo u t
and Run mo d es using the Layo u t / Run Mode co m m and in the 
Edit me n u.

Two to ol palettes also open: Doc Bui lder To ols and Cybe rd og Pa rt s. If
these palettes are in your way, you can move them to a diffe r e n t
loca tion on your screen, or close and reopen them when needed using
the Hid e / Sh ow Doc Bui lder To ols and Hid e / Sh ow Cybe rd og Pa rt s
co m m ands in the Layout me n u.
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3 Add a graphic to the top of the document by opening the Scrapbook (from the Apple [K]
menu), selecting any picture in it, and dragging the picture into the open document.

You can also co py the picture and then paste it in to the 
Doc Bui lder doc u ment. 

4 Center the graphic at the top of the DocBuilder document.

Once the picture appe a r s, it will pro ba bly be in the sel e cted state, but
cl ick ing anywhere with in the picture puts it in to its editable state. If
you need to drag or resize the pict u r e, be sure to do so while it is in the
s el e cted state and without rel e asing the mo use butto n. Rel e asing the
mo use button puts the picture in to its editable state and the resize an d
d r ag functions will not wo r k.

5 Select the text tool by clicking the icon marked with an A on the parts palette.

6 Move the pointer to the location where you want to place the text.

The pointer ch anges to a cro ss h a ir. 

7 Create the text area by dragging the crosshair while holding down the mouse button.

The text box in i tia l ly appears in its sel e cted state so that you can
r e p o si tion and size it. To put it in to its editable state, allow ing you to
add text, cl ick anywhere in side the box. The dotted border appe a r s, as
d oes a bl ink ing in s e rtion poin t .

8 Type the text, then change the font, color, and size to your liking.

Use the co m m ands in the Text menu to ch ange the si z e, styl e, fo n t, and 
colo r. You can apply style to any part of the text or all of the text,
d e pe n d ing on what you sel e ct. 

9 Resize the text box as needed to fit the text.

To resize the text box, cl ick the gray bord e r. Dark square han d l es
a p pear on the co rners of the button, in d ica ting that the text box part is
s el e cted. While the part is sel e cted, you can resize it by dragg ing one
of the han d l es so that all the text appe a r s.
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10 Add a button to the document by clicking the button icon in the parts palette and
dragging it into position in the DocBuilder window.

As you drag the button from the parts palette over the Doc Bui ld e r
w in d ow, the pointer ch anges to a cro ss h a ir. You can also create a butto n
by cl ick ing the icon and then dragg ing the cro ss h a ir, just as you did to
create a text box.

11 Adjust the size of the button as desired.

Dark square han d l es appear on the co rners of the button, in d ica ting
that the part is sel e cted. While the part is sel e cted, you can resize the
p a rt by dragg ing one of the han d l es. You can also sel e ct mul ti ple part s
by Sh i ft - cl ick ing and then align, move, or do other ope r a tions with the
p a rts as a gro u p.

12 Add a graphic to the button by dragging one from the Scrapbook.

If the graphic needs to be resized, you need to use a paint or draw
a p pl ica tion before you place the graphic in Doc Bui ld e r.

You can use an embedded picture to decorate your cybe r b u t to n :

a . Put the picture in to its editable (dotted border) state.

b. If ne c essa r y, resize the picture using the Picture menu that appe a r s
when the picture is in an editable state.

c. D r ag a sel e ction rect angle in side the dotted border to sel e ct all or
p a rt of the pict u r e.

d . Use the Co py and Paste co m m ands or just drag the sel e ction to 
the cybe r b u t to n.

You can have the icon of the item it points to appear on the button by
ch o o sing Sh ow Icon from the Cybe r Bu t ton me n u. Or you can type a
la bel on the button using the La bel option in the Cybe r Bu t ton me n u.

64 Chapter  6  C reat ing  Cyberdo cume nts



13 Set a color for the button using the CyberButton menu.

Besid es assig n ing a color to the button, you can make the button cl e a r
so that ba ck g round pict u r es can appear th ro ugh it.

14 Link the button to an Internet site by dragging an address icon from the desktop, the
Log, or any Notebook, to the button. You can also use the “Link to” items in the
CyberButton menu.

The button flas hes, in d ica ting that the In t e rnet address is linked to 
the butto n. (You can choose Get In fo from the Edit menu to find out to
wh ich In t e rnet site the button is linke d .)

To try out the button, sw i t ch the doc u ment to run mo d e. The
ba ck g round grid of dots disa p pears when you sw i t ch to run mo d e.
A fter yo u ' ve tried the button out, sw i t ch ba ck to layout mode in order to
m a ke additional ch anges to the doc u me n t .

15 Add a notebook by clicking the notebook icon in the Cyberdog palette.

You can drag the notebook to the Doc Bui lder win d ow, or sel e ct the
n o t ebook and then resize it with the cro ss h a ir.

Cyberdog
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Em bedded noteb o o ks be h ave exa ctly like noteb o o ks on your deskto p.
You can add, del e t e, and rearr ange items and ca t ego r i es and doubl e -
cl ick an item to go to the In t e rnet site it repres e n t s. The embe d d e d
n o t ebook even scrol ls, exa ctly like its desktop tw in.

You can put In t e rnet address es in the notebook by dragg ing them fro m
your Log, from an o ther noteb o o k, or from the Ma cin tosh deskto p
( Fin d e r ). You can also sel e ct the notebook and use the No t ebook me n u
to add ca t ego r i es or items to the notebook the sa me way as you do with
the defa ult noteb o o k.

16 Add a Web, FTP, AppleTalk, or Gopher view to a DocBuilder cyberdocument.

You can add real-ti me Web and Ap pl e Ta lk brows e r s, FTP, and Gophe r
si t es by dro p ping URLs on the Doc Bui lder doc u ment. Wait for the
co n ne ction, and the win d ow will open and resize itsel f. To resize the
b rows e r, first put it in to the sel e cted state by cl ick ing the dotted bord e r,
and then drag a han d l e. 

IMPORTANT  W hen a cybe rd oc u ment ope n s, embedded browser win d ows
a u to m a tica l ly co n ne ct to their si t es. Th is can ca use pro bl e ms for us e r s
who are not co n ne cted to the In t e rnet or the appro p r iate Ap pl e Ta lk
ne two r k. Cybe r b u t tons avoid th is pro blem be ca use they don’t make the
co n ne ction until cl icked by the us e r.

17 Add draw elements by selecting them from the DocBuilder palette.

The cro ssed lines give you horizontal or ve rtical lines; the angled line
lets you draw lines at va r io us angl es. You can also create boxes an d
cir cl es, or bord e r s, and you can add bevel effe ct s. The colored butto n s
let you sel e ct color for the border and its area; to sel e ct line width ,
choose Pens from the Layout me n u. 

18 Save the document.

You may want to save the doc u ment in run mode so that users can n o t
ch ange it, as des c r ibed earlier in th is ch a p t e r.
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access privileges  The ability to see or retrieve dir e cto r i es (folders) an d
fi l es, to make ch anges to a dir e cto r y, or to run prog r a ms at an FTP or
Tel ne t si t e. Acc ess privi l eges are granted by the admin is t r a tor of the
si t e. See also F T P, Te ln e t.

anonymous FTP  The proc ess you use to co n ne ct to a remote co m p u t e r
whose fi l es you can acc ess without having an account. It’s ca l l e d
a n ony m ous FTP be ca use you typica l ly type the wo rd “an o ny mo us” as
your user ID. See also F T P, rem o te compute r.

AppleShare  N e twork service software that allows users to store and share
d oc u me n t s, fold e r s, and appl ica tions over an Ap pl e Ta lk ne two r k.

AppleTalk  A co m m u n ica tions enviro nment in wh ich many diffe r e n t
k inds of co m p u t e r s, pe r i p heral devic es, and software can work toge the r
a cco rd ing to pro tocols (rul es) develo ped by Ap ple Co m p u t e r.

AppleTalk Filing Protocol (AFP)  The pres e n t a tio n - layer pro tocol that allows
users to share data fi l es and appl ica tion prog r a ms that reside on a fi l e
s e rve r.

bcc  In e-mail, a reci pient who receives a “bl ind co py” of a letter and its
a t t a chments (so called be ca use no other reci pients know about the bcc
r e ci pi e n t ). See also e - m a i l.

browser  Ap pl ica tion software you use to inves tigate the Wo rld Wide Web.
Cl ick ing the Explore button in the Cybe rd og Tour win d ow enabl es yo u
to browse the Web. See also Wo rld Wide We b.

cyberdocument Also known as a Cybe rd og cus tom doc u ment or
Doc Bui lder doc u me n t, th is is an Ope n Doc doc u ment that co n t a in s
In t e rnet functio n a l i t y. By cl ick ing hy pe rt ext links with in a
cybe rd oc u me n t, you can co n ne ct to In t e rnet si t es and dis play 
In t e rne t - based in fo rm a tio n. A cybe rd oc u ment offers ca p a bi l i ti es
si m i lar to that of a Web page, but unlike a Web page, Cybe rd oc u me n t s
a r e n’t in h ttp fo rmat. The Cybe rd og Tour win d ow that appears whe n
you start up Cybe rd og is an exa m ple of a cybe rd oc u me n t .
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Cyberdog document  See cyb e rdo c um e nt.

demoware  Software that you are allowed to try out at no ch a rge befo r e
p u r ch asing. Most demoware has bui l t - in limitations that prevent yo u
f rom using it on a pe rm anent basis.

directory  The wo rd for “folder” on many host co m p u t e r s.

DocBuilder  The Cybe rd og text and draw ing utility that you use to 
create cybe rd oc u me n t s.

download  To co py a file from an o ther computer to your own co m p u t e r
over a co m m u n ica tions link.

e-mail  E l e ct ro n ic mail.

freeware  Software that is dis t r ibuted at no cost. Dis tinguis hed fro m
sh a re wa re, for wh ich pay ment is reques t e d .

FTP  Ab b r evia tion for File Tr an sfer Pro tocol, the set of rul es (the
p ro tocol) that the In t e rnet us es to fa cilitate the tran sfer of fi l es 
be tween co m p u t e r s. 

Gopher  An in fo rm a tion retrieval system develo ped by the Unive r sity 
of Min neso t a .

header  The in fo rm a tion that appears at the top of every e-mail message
or newsg roup articl e. The header co n t a ins data about the sender, the
date the message was created, the computer path the message travel e d
th ro ugh, and other in fo rm a tion used for the dis t r ib u tion or man age me n t
of the message. See also e - m a i l, n ews g ro up.

home page  The defa ult Wo rld Wide Web doc u ment you go to when yo u
cl ick the Explore button in the In t e rnet Pa th fin d e r. See also 
brows e r, Wo rld Wide We b.

host computer  A remote computer that you co n ne ct to in order to retrieve 
m a i l, doc u me n t s, appl ica tion softwa r e, or other fi l es; search databas es ;
run prog r a ms; and take advan t age of other servic es the remo t e
computer may provid e.

HTML  An acro nym for Hy pe rt ext Markup Language, the fo rm a t ting
language that Wo rld Wide Web doc u ments are written in.

http  An acro nym for Hy pe rt ext Tr an sfer Pro tocol, the set of rul es th a t
the In t e rnet us es for moving hy pe rt ext doc u me n t s.
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hypertext  A system for nonlinear writing in wh ich doc u ments are
el e ct ro n ica l ly linked to other sections of text or other doc u me n t s. Se e
a lso hyp e rtext do c um e nt.

hypertext document  A doc u ment that co n t a ins text or graphics you can
cl ick to dis play additional in fo rm a tio n. Web pages and the
cybe rd oc u ments that you can create with Cybe rd og Doc Bui lder are
b o th exa m pl es of hy pe rt ext doc u me n t s.

Internet  The col l e ctive name for the sys t e ms of computer ne two r ks,
made up of millions of computers from all over the wo rld, that use the
sa me pro tocols for co m m u n ica tion and the exch ange of in fo rm a tio n. In
p r a ctical terms, the In t e rnet is a vast in t e rn a tional co m m u n ica tio n
system and reposi tory of in fo rm a tion acc essible by anyo ne with a home
co m p u t e r, pro per appl ica tion softwa r e, and an In t e rnet acc ess provid e r.

Internet access provider  A co m p any that provid es co n ne ctions to the
In t e rnet for a mo n th ly fee (or so me ti mes for an hourly fe e ). Acc ess
p roviders are to the In t e rnet as tel e p h o ne co m p an i es are to tel e p h o ne
s e rvice: they provide acc ess to the ne twork but don’t usua l ly 
p rovide co n t e n t .

Internet service provider  See I nte rnet access prov ide r.

moderated newsgroup  In Us e ne t, a newsg roup whose articl es are cl e a r e d
by a mo d e r a tor before they’re posted. An article posted to a mo d e r a t e d
newsg roup is auto m a tica l ly sent by e-mail to the gro u p’s mo d e r a to r,
who che cks the article for appro p r ia t e ness and then ei ther posts it to
the group or sends it ba ck to the author with an explan a tio n. Most
newsg roups are not moderated. See also Us e n e t.

newsgroup  In Us e ne t, a col l e ction of postings (called “a rticl es”) on the
sa me ge neral the me. Anyo ne can post an article to any unmo d e r a t e d
newsg ro u p. See also Us e n e t.

OpenDoc  Ap ple Co m p u t e r’s software that allows you to in t egrate many
in d e pendent parts in to a single doc u me n t .

page  A single Wo rld Wide Web doc u ment. Ea ch page can have text,
pict u r es, and other mul ti me d ia el e me n t s. A Web site can have any
n u m ber of pages co n ne cted by links.

pathname  The list of dir e cto r i es (folders) you pass th o ugh to get to the
d ir e ctory you want to us e. On the In t e rne t, the path n a me starts with a
slash (/), and all dir e cto r i es in the path n a me are separated by a slas h.
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remote computer  Also called a remote host, any computer that is in a
loca tion other th an where you are and that you use your own co m p u t e r
to co n ne ct to. Compare host compute r.

session  The current in t e r a ction be tween your computer and a 
r e mote co m p u t e r.

shareware  Software that is dis t r ibuted at no in i tial cost but for wh ich
p ay ment is requested should you co n tinue to use the prog r a m.

signature  Text that can be auto m a tica l ly added to the bottom of every 
e-mail letter or newsg roup article that you write. Gene r a l ly no lo nge r
th an four lines, the signature usua l ly co n t a ins a paper mailing address
and a voice or fax tel e p h o ne numbe r.

SMTP  An acro nym for Si m ple Mail Tr an sfer Pro tocol, the set of rul es
that the In t e rnet us es for moving e-mail messages. See also e - m a i l.

Telnet  P roc ess you use to log onto a remote co m p u t e r. Once yo u’r e
co n ne cted, your computer acts as a term inal to the remote co m p u t e r.
See also rem o te compute r.

thread  In Us e ne t, a series of articl es that dis c uss a co m mon to pic.
Articl es in the sa me thread have ne a rly the sa me name.

upload  To co py a file from your own computer to an o ther computer ove r
a co m m u n ica tions link.

URL  Ac ro nym for Unifo rm Resource Loca to r, the stan d a rd way to give
the address of any In t e rnet loca tio n.

Usenet  The set of all host computers that run the ne t news software an d
that exch ange newsg roups in the co m p, sci, rec, soc, mis c, news, an d
t a lk hierarch i es. (The exch ange of other newsg roup hierarch i es is
o p tio n a l .) Not all Us e net si t es are on the In t e rnet. St r ictly spe a k ing,
Us e net refers to the computers that run ne t news and to the pe o ple wh o
use th is servic e, rather th an to the newsg roups the ms elves.

World Wide Web  Also called the Web, the organ i za tion and pres e n t a tion of
In t e rnet in fo rm a tion in a series of hy pe rt ext doc u me n t s. Using a Web
b rows e r, you move th ro ugh the In t e rnet by cl ick ing images or text th a t
co n t a in hy pe rt ext links. (The text is usua l ly in a different color fro m
su rro u n d ing text and is often underl ine d .) See also brows e r, 
hyp e rtext do c um e nt.
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Index

A

addresses
adding to notebook  25–26, 37
of Cyberdog FAQ  13
of Cyberdog Home Page  11
default  31
deleting from notebook  37
Eudora addresses  38
format for  34
renaming  37
storing in notebook  12
suffixes in  34

Addresses button  34
addressing mail  34
Alta Vista Web page  23, 24
America Online, addressing mail for  35
anonymous FTP archives  46–49
Apple Computer Home Page  19
Apple Guide  9
AppleShare file servers

accessing  52
browsing and connecting to  12
links to  36
viewing in a zone  53

AppleShare URLs  54–55
AppleTalk browser, opening  52
AppleTalk button  12
AppleTalk networks, accessing  51–55
AppleTalk URLs  54–55
AppleTalk zones  52–53
AppleTalk zone URLs  54
archives, anonymous FTP  46–49
attaching files to mail messages  36
Australian users, newsgroup for  43

B

blind copies of mail (bcc)  35
bookmarks, importing  27–28
browsers

AppleTalk browsers  52
embedded browsers  61, 66
Web browsers  66

browsing
AppleShare servers  12
directories  48
the World Wide Web  17–20

buttons
adding graphics to  64–65
adding to cyberdocuments  64

buying hardware and software through 
Usenet newsgroups  43, 45

If you can’t find what you’re looking for 

in this index, look in Cyberdog Guide—

available in the Guide (h) menu 

on your computer.



C

Claris Emailer addresses  9, 28
composing messages  33
compressed files  50
CompuServe, addressing mail for  34
connecting

to AppleShare servers  12
to the World Wide Web  12, 17

copying mail
to additional users (cc and bcc)  35
to the server  33

cyberdocuments  57–66
adding AppleTalk and AppleShare URLs to  55
adding buttons to  64
adding Gopher sites to  66
adding graphics to buttons in  64–65
adding notebooks to  65–66
adding text to  63
adding Web browser, FTP, or Gopher sites to  66
basic controls for  58–61
buttons in  60
creating  62–66
deleting objects from  59
editable or uneditable  59
editing objects in  58–59
embedded browsers in  61
features of  58
graphics in  60, 63
saving  66
saving as run-only  60
Scrapbook as source of graphics and text for  60
scrolling text boxes in  61
selecting objects in  58–59
text in  60, 61

Cyberdog DocBuilder icon  62
Cyberdog FAQ, address of  13
Cyberdog Guide, downloading  11
Cyberdog Home Page, address of  11
Cyberdog Internet Search page  22, 48
Cyberdog Net Station page  18
Cyberdog Notebook. See notebook
Cyberdog Tour button, purpose of  12
Cyberdog Tour document icon  12
Cyberdog Tour window, appearance of  12

D

decompressing files  50
deleting objects from cyberdocuments  59
directories, browsing  48
DocBuilder. See also cyberdocuments

basic controls in  58–61
creating cyberdocuments with  62–66
purpose of  57
Tool palettes in  62

documents. See cyberdocuments
downloading

anonymous FTP archive files  47, 49
Cyberdog software  11
files with Gopher  49–50
software through Usenet newsgroup  44

E

editing
cyberdocuments  58–59
mail  36

e-mail. See mail
e-mail addresses. See addresses
embedded browsers  61, 66
Enclose button  36
Eudora addresses, importing  38
exchanging files with FTP  46–49
expanding compressed files  50
Explore button  17

F

file formats  36
files

accessing without a password  46
adding to mail messages  36
compressed and decompressed  50
downloading  49–50
retrieving and using  50
suffixes for  50
transferring with FTP  46–49
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file servers. See AppleShare file servers
File Transfer Protocol.  See FTP
file URLs  54
folder URLs  54
French users, newsgroup for  45
FTP (File Transfer Protocol)

adding FTP sites to cyberdocuments  66
anonymous FTP archives  46–49
finding files in an archive  48–49
finding FTP sites  48
transferring files with  46–49

G

Gopher  49, 66
graphics

adding to buttons in cyberdocuments  64–65
adding to cyberdocuments  63
adding to mail messages  36, 38
Scrapbook as source of  60

H

hardware, buying and selling through Usenet
newsgroups  43, 45

help
from alt.sys.mac.newuser-help newsgroup  43
from Apple Guide  9
from Cyberdog FAQ  13

Home Pages
Apple Computer Home Page  19
Cyberdog Home Page  11

“hot text” on Web pages  19
hypertext links  16, 19–20
Hypertext Transfer Protocol (http)  15, 20

I

installing Cyberdog software  11
Internet. See also World Wide Web or specific topic

scanning with search engines  12
storing Internet locations in notebook  12, 25–26

In Tray  30

J, K

Japanese users, newsgroup for  45

L

letterheads in mail messages  38
Location (URL) window on Web pages  20
Log button  12

M

mail
adding files to  36
addressing  34
blind copies of (bcc)  35
checking setup for  30
composing  33
copying to additional users (cc)  35
copying to the server  33
editing  36
file formats and  36
graphics in  36, 38
letterheads in  38
notification features for  32
opening  33
password for  32
Plain Text option for  36
replying to  33
screening  35
sending  33
sending to members of online services  35
setting up for  31–33
signatures in  38
subject of  35
typing  36

Mail button  12, 30
Mail Trays window  30
MCI Mail, addressing mail for  35
memory requirements  10
messages. See mail
Messages icon  33
modem requirements  10
moving among Web pages  16, 19–20



N

Netscape bookmarks, importing  27–28
News button  12
newsgroups. See Usenet newsgroups
notebook

adding addresses to  25–26, 37, 66
adding AppleTalk URLs to  54
adding Internet addresses to  66
adding to cyberdocuments  65–66
adding Web pages to  25–26
addressing mail in  34
deleting addresses from  37
renaming addresses in  37
storing bookmarks in  27–28

Notebook button  12

O

online help. See help
online services, addressing mail to members of  35
OpenDoc 1.1, downloading  11
opening mail  33

P, Q

pages. See Web pages
password

accessing files without  46
entering and saving  32

Plain Text option  36
Prodigy, addressing mail for  35

R

RAM requirements  10
replying to mail  33
retrieving files  50
run-only cyberdocuments  60

S

saving cyberdocuments  60, 66
screening mail  35
scrolling text boxes  61
Search button  12, 22
search engines  12, 21–24
searching for information on the World Wide Web

21–24
Search page, locating FTP sites with  48
selecting objects in cyberdocuments  58–59
selling hardware and software through Usenet

newsgroups  43, 45
Send button  36
sending mail  33
Send Later button  36
servers. See also AppleShare file servers

attachments and  36
performance of  28

shareware  50
signatures in mail messages  38
SMTP host  31
software

buying and selling through Usenet newsgroups
43–45

installing  11
required by Cyberdog  10
shareware  50
technical support for  46

starting up  12
subject field for mail  35
subscribing to Usenet newsgroups  43
suffixes for files  50
“surfing” the World Wide Web  17–20
system requirements  10
system software, recommended version of  10

T

Texas A&M University, newsgroup 
for  45

text, adding to cyberdocuments  61, 63
text boxes, scrolling  61
Tool palettes in DocBuilder  62
transferring files with FTP  46–49
troubleshooting  13
typing mail messages  36
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U, V

Uniform Reference Locators. See URLs
upgrading system software  10
URLs

AppleTalk and AppleShare URLs  54–55
adding to notebook  54–55
http:// prefix in  20
Location (URL) window on Web pages  20

Usenet newsgroups
basics of  40–41
for Australian users  43
for buying and selling hardware and 

software  43, 45
for Cyberdog issues  44
for downloading software  44
for French users  45
for Japanese users  45
for Macintosh users  43–45
for new users  43
for Texas A&M University  45
hierarchy and subject matter of  42
names of  41–42
subscribing to  43

W, X, Y

Web. See World Wide Web
Web browser sites, adding to cyberdocuments  66
Web pages

accessing  16, 19
adding to notebook  25–26
Alta Vista Web page  23, 24
Apple Computer Home Page  19
bookmarks for  27–28
Cyberdog Home Page  11
Cyberdog Internet Search page  22
Cyberdog Net Station page  18
“hot text” on  19
Location (URL) window on  20
moving among  16, 19–20
searching a series of  19
searching for  21–24

World Wide Web. See also Internet or specific topic
adding Web sites to your notebook  25–26
browsing   17–20
connecting to  12, 17
definition of  15
how it operates  16
searching for specific information on  21–24
server performance and  28

Z

zones. See AppleTalk zones
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